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VirtuCath™ - User Manual  
1. Introduction  
Welcome to VirtuCath™!  

VirtuCath is a simulation tool designed for the rapid design and digital prototyping of 
deflectable micro-catheters. Powered by the MuJoCo physics engine from Google 
DeepMind, VirtuCath enables you to intuitively define catheter properties, observe 
simulated behavior, and analyze results within an interactive 3D environment. At its core, 
the application constructs a "digital twin" of your catheter design, allowing you to 
manipulate its deflection through virtual pullwires and gain insights into its mechanical 
performance and reach.  

VirtuCath is intended as a design aid and for preliminary simulation purposes only. The 
results generated by this software are based on a simplified physics model and should not 
be considered a substitute for comprehensive physical prototyping, rigorous testing, or 
formal Verification and Validation (V&V) activities required for medical devices or other 
critical applications.  

The simulation makes certain assumptions and simplifications, including but not limited to, 
primarily linear material behaviors and idealized mechanics. Furthermore, axial and shear 
deformation of the catheter sections is not modeled, under the assumption that the axial 
and shear stiffness is significantly greater than the bending or torsional stiffness. The 
simulation does not account for all complex non-linear phenomena such as large elastic 
deformations, kinking, material hysteresis, or intricate contact mechanics that might be 
captured by more exhaustive Finite Element Analysis (FEA) packages.  

Users should exercise their own professional judgment when interpreting the simulation 
results and are solely responsible for the design, testing, and validation of any physical 
product based on or informed by the use of this software. VirtuCath, LLC disclaims any  
and all liability for decisions made or actions taken based on the information provided by 
VirtuCath.  

This manual serves as your comprehensive guide to the features and usage of 
VirtuCath. 
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2. System Requirements  
To run VirtuCath, you will need:  

Microsoft Windows 10 or higher.  

A processor capable of handling physics simulations (e.g., Intel Core i5 or AMD 
Ryzen 5, or newer, is recommended for a smooth experience).  

At least 4GB of RAM (8GB or more recommended).  

A graphics card supporting OpenGL 3.3 or higher for the 3D viewer.  

3. Getting Started  
 

3.1. Launching VirtuCath  
To launch the application, simply double-click the VirtuCath.exe file. 

 3.2. Main Window Overview  
The VirtuCath main window is divided into several key areas:  

Menu Bar: Provides access to file operations.  

Left Panel (Tabs):  

Catheter Setup Tab: Define the physical and mechanical properties of your 
catheter.  

Simulation Control Tab: Control the simulation in real-time. 

Middle Panel (3D Viewer): Displays an interactive 3D rendering of the catheter 
simulation.  

Right Panel (Data Readout): Displays multiple key parameters of the simulation. 
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4. Catheter Setup Tab  
The catheter setup wizard guides you through defining the geometry and characteristics 
of your catheter design.  

4.1. General Properties  
 

Catheter Name: Assign a unique, descriptive name for your catheter design. This 
name will be automatically assigned to exported images and data logs. 

Number of Catheter Sections: Define how many distinct sections your catheter 
comprises (e.g., a proximal shaft, a flexible bending section, and a distal tip). 

ℹ️ Note: For best performance, define only the flexible or steerable distal 
portion of the catheter that you intend to simulate. Simulating the entire 
length of a long device may cause instability or slow performance. 

Load Config from File: Loads a previously saved catheter design from a 
configuration file. This bypasses the setup wizard and immediately generates the 
interactive model based on the file's parameters. Also accessible via File > Load 
Config.. 
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4.2. Section Lengths 
 

Defined for each section) 

Label: Provide a descriptive name for the section (e.g., "Distal Tip"). This name will 
identify the section in data readouts and exported log files. 

Length: Specify the length of this catheter section. 

ℹ️ Note: Section length must be between 3 mm (0.12 in) and 800 mm 
(31.5 in). Modeling multiple long sections may decrease simulation 
performance and stability. 

Color: Choose a distinct color to help identify this section in the 3D viewer. Click the 
color swatch to open the selection dialog. 

 

​  
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4.3. Geometry and Actuation  
 
Global Properties: 
Overall Diameter: Specify the overall outer diameter of the catheter. This 
dimension is used for visualization and helps in contextualizing the pullwire offset.  

French Size: The software automatically calculates the catheter french size based 
on the diameter, rounding up to the nearest half french size. 

Pullwire Arrangement:  

None: Not steerable.  

Single Pullwire: Simulates a catheter with one pullwire, typically 
for uni-directional deflection.  

Two Pullwires: Simulates a catheter with two pullwires, oriented 180 
degrees apart relative to each other.  

Four Pullwires (default) : Simulates a catheter with four pullwires, 
oriented 90 degrees apart relative to each other. This allows for 
bi-directional steering.  

Radial Offset from Centerline: The perpendicular distance from the catheter's 
central axis to the centerline of the pullwire(s). This value must be less than the 
catheter radius.  

Pullwire Anchoring: Defines after which section the pullwires are anchored on 
the catheter.  

Pullwire Lumen Diameter: This value is used in modeling the section moment 
of inertia of the catheter sections. If you wish to exclude it from the mechanical 
analysis, set it to an arbitrary very small value. 

Include Lumen Liners: 

Use this checkbox to include pullwire lumen liners in the calculation:  

●​ If unchecked, the lumens are modeled as unlined 
●​ If checked, you can select the liner material and wall thickness 
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4.4. Section Construction 
Define the construction for each catheter section.  

Number of Layers  

Select the number of layers in your catheter constructions. Layers are 
defined from the outside-in, with Layer 1 being the outermost layer. 

​ Layer Properties 

This panel allows you to define the mechanical construction for each specific 
section of the catheter (as defined in the previous "Lengths" step). 

Visual Feedback 

At the top of the panel, a Cross-Section Visualizer displays a dynamic, scaled 
representation of your catheter's layers, materials, and internal lumens. This 
view updates in real-time as you modify layer properties. 

General Settings 

Number of Layers - Select the total number of layers in this section's 
construction. 

Manage Materials - Click this button to open the Material Library, where you 
can create, edit, or import custom polymer and wire materials. 

Layer Properties 

Layers are defined from the Outside-In, meaning Layer 1 is the outermost jacket, 
and the final layer is the innermost liner. 

Name - An optional label for the layer (e.g., "Outer Jacket," "Braid," "Liner"). 

Material - Select the polymer or matrix material for this layer. For reinforced 
layers, this defines the matrix material embedding the wires. 

Reinforcement - Choose the structural type of the layer: 

●​ None - A pure polymer layer. 
●​ Braid - A woven wire reinforcement pattern. 
●​ Coil - A helical wire reinforcement pattern. 

Thickness -  

●​ For Non-Reinforced Layers - Enter the wall thickness manually. 
●​ For Reinforced Layers - This field is Read-Only. The software 

automatically calculates the thickness based on the wire dimensions 
(2× wire thickness for Braids, 1× wire thickness for Coils). 
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Dimensions (ID/OD) - Displays the calculated Inner Diameter (ID) and Outer 
Diameter (OD) based on the cumulative thickness of previous layers. 

Reinforcement Settings - If "Braid" or "Coil" is selected, a sub-panel appears to 
define the wire geometry. A dynamic preview of the pattern (including calculated 
braid angle) is displayed. 

Common Settings: 

●​ Wire Material - Select the metal (e.g., Stainless Steel, Nitinol) from 
the material library. 

●​ Wire Shape - Choose between Round or Flat/Ribbon wire. 
●​ Wire Dimensions - 

○​ Round: Enter the wire diameter. 
○​ Flat: A dropdown of common ribbon sizes is provided for quick 

selection or enter a custom thickness and width.  

Braid Specifics: 

●​ Picks Per Inch (PPI) - The number of wire crossings per inch of 
length. 

●​ Number of Carriers - The number of bobbins used in the braiding 
machine (e.g., 16, 32, 64). The calculations assume one wire per 
carrier. 

●​ Calculated Angle - The software displays the resulting braid angle 
relative to the longitudinal axis. 

Coil Specifics: 

●​ Pitch - The distance between the center of one wire wrap to the 
center of the next. 

​ Results: 

Bending Stiffness (EI) - Also known as Flexural Rigidity, this value defines 
the section's resistance to bending. 

Torsional Stiffness (GJ) - Also known as Torsional Rigidity, this value 
defines the section's resistance to twisting. 

Central Lumen ID: Calculated based on the catheter OD and sum of layer 
thicknesses. 

​ Manual Override Options: 

These settings override the detailed catheter construction calculations for the 
section. 

Is Rigid - If checked, the section is modeled as a single, non-deformable 
rigid body. The stiffness fields below are disabled. 

Bending Stiffness (EI) - Allows you to manually override the calculated 
value. 
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Torsional Stiffness (GJ) - Allows you to manually override the calculated 
value. 

●​ Auto Mode: By default, GJ is set to 10% of the EI value, which is a 
reasonable approximation for braided catheters. 

●​ Custom Mode: To enter a specific number, click the "Auto" button to 
switch it to "Custom" mode. This allows you to input your own value. 
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ℹ️ Note: Multi-Lumen Cross-sections 

VirtuCath does not currently support multi-lumen cross-section designs. To simulate a 
multi-lumen catheter dynamically:  

●​ Calculate the area moment of inertia of the multi-lumen layer. Please note that 
asymmetric cross-sections are not supported, pick the section moment of inertia of 
interest for the simulation. 

●​ For a given layer OD, calculate the layer thickness so that the ring segment has the 
area moment of inertia equivalent to the desired value. 

●​ Some calculated catheter properties like torsional and axial stiffness, kink radius, 
burst pressure, etc. will not be accurate for a simulated multi-lumen catheter. 

ℹ️ Note: Alternative Methods to Determine Stiffness Values (EI & GJ) 

Accurate bending stiffness (EI) and torsional stiffness (GJ) values are essential for a 
realistic simulation. If these properties are unknown for your design, here are three 
common methods to determine them: 

1. Calculation from Geometry 

This is ideal if you have a CAD model of the catheter's cross-section and know the material 
properties. 

●​ Bending Stiffness (EI): The material's Young's Modulus (E) multiplied by the 
cross-section's Area Moment of Inertia (I). 

●​ Torsional Stiffness (GJ): The material's Shear Modulus (G) multiplied by the 
cross-section's Polar Moment of Inertia (J). 

2. Physical Measurement 

Directly testing a physical sample is the most accurate method, as it captures the 
real-world performance of the manufactured component. 

●​ Bending Stiffness (EI) is typically found using a three-point bend test, where a 
known force is applied to a sample and the resulting deflection is measured. 

●​ Torsional Stiffness (GJ) is found by fixing one end of a sample, applying a known 
angle of twist at the other and measuring the torque. 

While high-precision test equipment is ideal, simple benchtop setups can often provide 
reasonable estimates for simulation purposes. 
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4.5. Review & Build  
 
This is the final step where you can review your design before creating the simulation 
model. 

Color Bar: A scaled diagram of your catheter design. A black line indicates the 
pullwire termination point. 

Configuration Summary: Review all entered parameters before building the 
model. Click the "Edit" link next to any item to return to that section and make 
changes. 

Save Config to File: Saves the current catheter design to a file. This allows you 
to reload the design later or share it with colleagues. This function is also 
available from the main menu via File > Save Config.. 

Build and Run Model: Click this button to generate the simulation. VirtuCath will 
build the physics model based on your inputs and automatically load it in the  
interactive 3D viewer. 
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5. Live Controls  
This tab is the primary interface for interacting with the live simulation. It is used to 
manipulate the catheter's pullwires and manage the state of the physics simulation. 

5.1. Simulation Controls  

Run/Pause Simulation: This is a toggle button that controls the physics engine. 
When the simulation is paused, the button text is Run Simulation. When active, the 
text changes to Pause Simulation. 

 
ℹ️ Note: The simulation will pause automatically after five minutes of 
run time. It can be resumed if additional time is needed. 

Reset: Stops the simulation, resets the catheter to its initial straight 
configuration, and clears all data.  

5.2. Catheter Motion Controls  

This section allows for the control of catheter deflection by simulating pullwire 
displacement. The controls shown will automatically adapt based on the catheter's 
pullwire configuration (e.g., the Y-axis control is only enabled for four-pullwire designs). 

Jog Control (X & Y): This control incrementally adjusts pullwire 
displacement. 

Clicking a button jogs the position in the indicated direction (+X, -X, +Y, or 
-Y). Each of the three rings corresponds to a different step size, allowing 
for fine, medium, or coarse adjustments. Clicking the Home button resets 
that axis to its zero position. 

Deflection Input Box Located below the dials, this field serves two functions: 

Readout: It displays the current commanded displacement for the axis. 

Direct Input: A precise numerical value for deflection can be typed 
directly into the box. 

 

Copyright © 2025 VirtuCath, LLC. All Rights Reserved. 



VirtuCath™ - User Manual | VR-UM-001 Version: 2.5 | November 30, 2025  

 

 
 

 

Copyright © 2025 VirtuCath, LLC. All Rights Reserved. 



VirtuCath™ - User Manual | VR-UM-001 Version: 2.5 | November 30, 2025  

6. 3D Viewer  
The 3D Viewport provides an interactive rendering of the physics simulation.  

6.1. Mouse Controls  
Interact with the 3D view using your mouse:  

Rotate: Left-click and drag to orbit the camera around the model.  

Pan: Right-click and drag to move the view vertically and horizontally. 

Zoom: Use the mouse scroll wheel to move the camera closer to or further from 
the model. 

6.2. Preset Views 
Located in the upper right corner of the 3D viewer, these buttons allow you to quickly 
snap to standard viewing angles. Use the number keys to snap the camera to standard 
views and display or hide XYZ axis. 

  

7. Simulation Readout Panel  
This panel provides a real-time dashboard of key performance indicators from the 
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simulation. 

7.1. Overall Performance Metrics 

This top section displays key values for the catheter as a whole. 

X/Y Pullwire Displacement: The commanded displacement value for the pullwires 
along each primary axis. 

Tip Angle (Theta): The total integrated bend angle of the catheter tip relative to its 
base, reported in degrees. 

Tip Angle (Phi): The azimuthal angle, representing the rotational direction of the 
bend. A value of 0° indicates a bend purely in the +Y direction, while 90° indicates a 
bend purely in the +X direction. 

 

X/Y Wire Tension: The simulated reaction force in each individual pullwire.  

ℹ️ Note: This value is not accurate during motion due to dynamic effects, 
wait for the catheter to settle for an accurate tension reading. 

Total Strain Energy: The total potential energy stored in the catheter due to 
bending and twisting. 

Tip Position (X,Y,Z): The spatial coordinates of the distal tip of the catheter in the 
3D world with the proximal end of the catheter serving as the origin. 

Tip Quat (W,X,Y,Z): The orientation of the catheter tip expressed as a quaternion. 
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7.2. Per-Section Analysis 

This area provides calculated metrics for each individual flexible section defined in the 
catheter setup. Rigid sections are excluded from these calculations. 

Bend Radius: The simulated radius of curvature for each flexible section. A very 
large number or "--" indicates the section is currently straight. The value will turn red 
if the bend radius falls below the calculated critical kinking radius. 

Bending Moment: The internal moment within each section resulting from 
deflection forces. The value will turn red if the bending moment exceeds the 
calculated maximum moment at material failure. 

Ovalization: When a catheter section is bent, the cross-section deforms into an 
oval shape. This occurs because differential stresses—tension on the outer curve 
and compression on the inner curve—cause the section to flatten perpendicular to 
the plane of bending. This phenomenon is critical to characterize for maintaining 
Inner Diameter (ID) clearance, as the dimensional change can lead to increased 
friction when navigating ancillary components. VirtuCath calculates the ovalization 
of the catheter Outer Diameter (OD) and ID for each section, displaying the 
resultant major and minor axis dimensions. 
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8. Catheter Analysis Panel 
8.1. Stiffness Properties 
​  

Bending Stiffness (EI): This value, also known as Flexural Rigidity, defines the 
catheter section's resistance to bending. 
 
Torsional Stiffness (GJ): This value, also known as Torsional Rigidity, defines the 
catheter section's resistance to twisting. 
 
Axial Stiffness (EA): This value represents the resistance to stretching and 
compression along the axis. 
 

​ Linear Density: This is the mass per unit length of the section. 

8.2. Failure Mode Analysis 
 

Critical Buckling (Euler): The maximum compressive axial force a section can 
withstand before it suddenly bows or buckles, representing a crucial measure of the 
catheter's pushability. 

 
Kink Radius (Brazier): The minimum radius of curvature a section can sustain 
before structural collapse due to kinking. 

​  
Max Moment (Material Failure): The maximum internal bending moment the 
section can withstand before the material reaches its yield or ultimate stress limit. 

 
Tensile Failure Load: The maximum axial pulling force that can be applied to the 
section before it breaks. 

 
Torque Failure: The maximum twisting force (torque) that can be applied to the 
section before it breaks. 

 
Burst Pressure: The maximum internal fluid pressure the section can contain 
before its wall ruptures. 

 
External Crush Pressure: The maximum external pressure the section can 
withstand before its structure collapses inward. 

8.3. Calculated Reinforcement Characteristics 
 
Braid/coil characteristics are calculated for each reinforced layer for each catheter section. 
​  
​ Angle: Wrap angle of the braid/coil wire. 
​ Pitch: The axial distance between successive wraps of the braid or coil wire. 
​  

Coverage: The percentage of the catheter's surface area covered by the reinforcing 
wires. 
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9. Menu Bar  
The menu bar provides access to file operations, unit system selection, and application 
help.  

9.1. File Menu  
Load Config: Opens a file dialog to load a catheter design from a .json file. The 

configuration is automatically applied, and the model is rebuilt.  

Save Config: Opens a file dialog to save the current parameters from the "Catheter 
Setup" tab to a .json file.  

Export:  

Export Image: Saves the current 3D viewport as a PNG or JPG image file.  

Analysis Report (PDF): Exports a comprehensive analysis and summary report as 
a PDF document. 

Analysis Report (Excel): Exports a comprehensive analysis and summary report 
as an Excel spreadsheet. 

Simulation Run Log to CSV: Exports all historical data from the simulation 
into a single .csv file. 

Exit: Closes the application.  

9.2. Units Menu  

Use Metric Units: Sets all relevant UI displays, controls, and plot axes to metric 
units (mm, N).  

Use Imperial Units: Sets all relevant UI displays, controls, and plot axes to 
imperial units (in, lbf)  

9.3. Materials Menu  

Manage Material Library: Opens the material manager dialog, allowing for the 
customization or addition of new materials. 

Create Custom Blend: Opens the polymer blending utility to create custom 
material blends from existing library materials. 

9.4. Help Menu  

Manual: Opens the VirtuCath user manual PDF document.  

About: Displays information about the application and its version.  
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10. Licensing & Activation 
VirtuCath™ offers flexible licensing options designed to scale from individual innovators to 
enterprise engineering teams. This section guides you through managing your software 
license. 

10.1. Free Trial 

New users automatically receive a 15-day full-feature trial upon installation. 

●​ No Key Required: Simply install and run VirtuCath. The trial starts 
automatically on the first launch. 

●​ Full Access: All simulation and export features are available during the trial 
period. 

●​ Expiration: After 15 days, the software will lock and prompt you to enter a 
valid license key to continue. 

10.2. Purchasing a License 

You can purchase a commercial license directly from the website. We offer two 
primary ways to buy: 

Instant Purchase (Credit Card) 

Best for individuals and small teams who need immediate access. 

1.​ Visit virtucath.com. 
2.​ Select your plan (Innovator or Team). 
3.​ Complete checkout securely via Paddle. 
4.​ Instant Delivery: You will receive an email with your License Key 

immediately. 

Enterprise Quotes (Purchase Order) 

Best for corporate procurement requiring a formal quote and invoice. 

1.​ Visit our Quote Request Page. 
2.​ Fill out your company details. 
3.​ Instant Quote: You will receive a formal PDF quote via email immediately. 
4.​ Process: Reply to that email with your Purchase Order (PO) number. We will 

then issue the formal invoice and release your license keys. 
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10.3. Activating Your License 

Once you have your License Key (e.g., VC-INN-XXXX-XXXX), follow these steps to 
unlock the full version: 

1.​ Open VirtuCath. 
2.​ In the top menu bar, go to Help > Activate License. 
3.​ Enter your License Key in the dialog box. 
4.​ Click Activate. 
5.​ Restart VirtuCath to apply the changes. 

Note: An internet connection is required for the initial activation. 

10.4. License Management 
 

Multiple Seats (Team/Business Plans) 

If you purchased a multi-seat license (e.g., Team Starter or Business Plan), you will 
receive one single Master Key. 

●​ Distribution: Share this same key with your team members. 
●​ Activation: Each user activates the software on their own computer using 

this key. 
●​ Seat Tracking: Our system automatically tracks the number of active 

devices. If you exceed your seat limit, additional activations will be blocked. 

Transferring a License (New Computer) 

Licenses are "node-locked" to the specific computer hardware. 

●​ Scenario: You get a new laptop or an employee leaves the company. 
●​ Action: Please email support@virtucath.com with your License Key and 

the name of the old machine you wish to deactivate. 
●​ Result: We will remotely free up that seat so you can activate it on the new 

hardware immediately. 

Renewals 

●​ Manual Renewal: Licenses do not auto-renew. You will receive a reminder 
email before your license expires. 

●​ Seamless Extension: When you purchase a renewal, your existing License 
Key is automatically extended. You do not need to enter a new key; simply 
restart the application while connected to the internet, and it will update the 
expiration date automatically. 
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10.5. Troubleshooting 
Issue Solution 

"Please connect 
to internet" 

The software needs to verify your license periodically (every 30 
days). Connect to Wi-Fi and restart the app. 

"All seats used" Your team has used all available activations for this key. Contact 
support to purchase more seats or deactivate an old machine. 

"Invalid Key" Double-check for typos. Ensure there are no leading/trailing 
spaces when copying the key. 

Trial Expired Your 15-day evaluation period has ended. Please purchase a 
license to continue using VirtuCath. 

For any other licensing issues, please contact support@virtucath.com. 
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